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Finding the 25th Hour: A How-to for Lawyers 

 

Presented by: 

Christopher T. Anderson 
Product Manager, LexisNexis Firm Manager 
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Christopher T. Anderson 

Christopher Anderson, J.D. 
Product Manager for LexisNexis Firm Manager®, LexisNexis 
  
• Mr. Anderson is the Product Manager for the LexisNexis 

Firm Manager application in Cary North Carolina.   
• Firm Manager is a web-based practice management system 

that keeps the attorneys and staff of small law firms 
connected to all the details of their clients, cases, matters 
and firm business.   

• Christopher has presented at various State Bar 
associations, Law Bulletin Ethics Conference, National CLE 
conference, ABA TECHSHOW, and draws several hundred to 
webinars where he presents various topics, including 
running a law firm; effectively using technology and 
leveraging staff; and technology and trends.  

 
Formerly: 
• Managing partner of a full-service law firm in Georgia.   
• Assistant district attorney in New York City, and in Georgia 
• Associate General Counsel and Director of Client Services 

for RealLegal, a legal software company.  
  
Mr. Anderson is a graduate of Cornell University, and received 
his Juris Doctorate from the University Georgia School of Law 
in 1994. Christopher Anderson is admitted to practice in the 
federal and state courts of New York and Georgia. 
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Finding the 25th Hour: A How-to for lawyers 

Repetitive tasks, Broken processes,  
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Cloud Computing – Put Simply 

 
 

 

(n.) A style of computing in which  
• Software 
• Storage 
• Processing Power 
• Other Computing Services 

are provided over the internet and  
usually accessed via web browser or mobile 
application.  

1
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Cloud Computing Features 

• Service turns on & off 
• No expertise needed 
• Updates automatically 
• Scalable  
• Defined and understandable costs 
• Has backup 
• Offers guarantees 
• Governed 
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What should you Consider when Considering “Cloud” 

But it requires due diligence on: 
 
1. Data Protection 

 
2. Data Ownership 

 
3. Availability 
 

The product, offering or application should help 
you solve important problems or jobs. 
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1. Data Protection 

At bare minimum, vendors should provide better-than-yours  data 
security.  Ask them about:  
 
•Encryption type? 
•Environmental security? 
•Testing methods? 
•Real-time intrusion monitoring? 
•Third party certifications? 
•Internal controls? 

 

 
 

The only truly secure computer is the one unplugged from the wall and locked in a 
vault.  
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Who to trust? 

2



8 

2. Data Ownership 

Questions to ask:  
 
• What are your contract terms/conditions? 
• Policies on Government requests? 
• Data return procedures? 
• What happens when you cancel? 
• How are third parties vetted? 
• Use of my data internally? 
• Is any anonymized information used? 

 

 
 
Above all, your confidential client data belongs to you.  
 
 
 

9 

− BRAND X will have no responsibility for any harm to your computer 
system, loss or corruption of data, or other harm that results from your 
access to or use of the Services or Software 

− BRAND X: If you add a file to your [Brand X] that has been previously 
uploaded by you or another user, we may associate all or a portion of the 
previous file with your account rather than storing a duplicate 

− BRAND Y: When you upload … content to our Services, you give Brand Y 
(and those we work with) a worldwide license to use, host, store, 
reproduce, modify, create derivative works … communicate, publish, 
publicly perform, publicly display and distribute such content.  

− BRAND Y: Your domain administrator may be able to … access or retain 
information stored as part of your account [and]restrict your ability to 
delete or edit information… or privacy settings. 

2. Data Ownership 

 
Actual Terms and Conditions from (non-legal focused) Cloud Vendors… 
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3. Data Availability 

 
Questions to ask:  
 
• Uptime guarantees? 
• Financial penalties? 
• Number of data centers? 
• Testing? 
• Backups? 

 

 
 
 
Bottom line: Your cloud provider should be there when you 
need them. 
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Other Considerations:  Your Needs 

• Your budget 
• Trial periods 
• Total cost of ownership 
• Customer support & training options  
• Any additional fees 
• Data migration 
• Email integration 
• Reputable players  
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Other Considerations: Functionality 

Practice Management Expectations 
 
• Global & Conflict of interest search 
• Access controls 
• Custom AOP tools 
• Mobility solutions 
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Conflict of Interest Search 

14 

Global Search 

15 

Practice Templates & Data Exporting 

4
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Native Apps vs. Web 2.02 

Type of Application Mobile Web-Based Device-Specific 

Example LexisNexis Time Matters mobility 
solution (using Azure platform) / 
Firm Manager (proprietary platform) 

iPhone or Android App 

Who Can Use It Anyone with a mobile web browser 
and live Internet connection 

Only those with that specific device  

Installation Requirements No application installation is 
required if you already have a web 
browser on your phone/mobile 
device 

Application must be installed on your phone/mobile 
device 

Where Data Is Stored On premise at the law firm or in the 
cloud in a secure data center 

On the phone 

How Updates to the Mobile 
Application Are Delivered 

Automatically through the 
Internet—no action required on 
your part other than authentication 

You must update the application on your 
phone/mobile device  

17 

Example 

• Cloud Based 

• No Management Costs 

• Consistent experience 

across all web-enabled 

devices 

• Optimized for your device 

18 

Q & A 
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James Province  

James Province aka @tabletlawyer 
 
James Province, founder of Tabletlawyer, LLC who was a busy solo 
practice lawyer in Poulsbo, WA, who through the use of a tablet 
PC, has taken great strides in his organization and productivity.  He 
is now passionate about introducing the technology to other 
lawyers to help improve their practice as well. James currently 
works as a mediator using his legal knowledge and mediation skills 
along with his passion for technology to help parties reach 
reasonable conclusions in disputes. 
  
After earning his B.A. from Westmont College and his J.D. from the 
University of Iowa, James Province began a small-town law 
practice in the Seattle area.  For the twenty years, he has focused 
on domestic relations matters, handling everything thing from 
child support issues to complex divorce cases.  
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MICROSOFT OFFICE 365 TIPS/TRICKS FOR LAWYERS  
BY JAMES PROVINCE, J.D.  

FOUNDER OF www.TabletLawyer.com  
james@provincelaw.com 

360.697.2000 
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How to get the 25th Hour Solution Personalized for Your Law 
Office 

The Turn-Key Solution for Lawyers 

From concept to execution, technologist and JD James Province will design a custom program 
for each seat in your firm (attorneys and assistants) to get you moving forward quickly with 
Microsoft® Office 365™ products.  

Here’s what’s included: 

 Initial setup of Office 365™ account using email from your domain (not the standard 
xxx.onmicrosoft.com address assigned to you by Office 365™)  

 Setup of current domain (assumes that you own your own internet domain) to point to 
Office 365™ Exchange Server 

 Migration of existing email/calendar/contacts for each seat to Office 365™ Exchange 
Server 

 Personal guidance for each seat to set up email/calendar/contacts to sync on a smart 
phone 

 Setup of Lync online for each seat to sign in with email address 

 Office 2010 components downloaded to each desk and installed with current updates 

 Configured access to your firm’s SharePoint site and one person assigned in firm to be 
administrator for SharePoint 

 One hour of group Office 365™ training online for lawyers and staff per firm by James 
Province (to be mutually scheduled) 

Options  

Other customized collaboration and communication functions are available for additional fees, 
including: 

 Set up SharePoint site with sub-sites and transfer documents 

 Lync Server on-site for Enterprise Voice (telephone capabilities) OR Hosted Lync for calls 
without on-site server 

 Ongoing IT support for Office 365 maintenance or other IT services 

 Additional personalized training from James Province 

Get Your Custom Solution Now 

To get Microsoft® Office 365™ custom setup and training for your firm, contact email James 
Province here, or call 360-697-2000.  James will work with each law firm to connect them with 
the pre-screened Microsoft® IT Partner best suited to their needs. 
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Microsoft Word: 

 Customize Word for your best use (customize Ribbon and Quick Access Toolbar).  Go to 

File>Options>Select Either Customize Ribbon Or Quick Access Tool Bar>Make Choices. 

 
 

   Arrow hides Ribbon. 
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 Cut and paste.  Right Click>Select A for Text Only which keeps format in document in.  

Select Paintbrush for Keeping Source Format. Hover for preview. 

 
 

 Format Painter. Highlight text you want to copy the format of>Click Format 

Painter>Paint text you want to change the formatting on. 

 
 

 Protecting/Scrubbing Documents and Permissions. File>Info>Select Permissions or 

Preparing for Sharing. 
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 Recover Lost Work.  File>Info>Versions>Manage Version. 
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 Using Track Changes to capture each change and who made the change.  Review>Track 

Changes>Accept/Reject. Don’t forget options.
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 Compare Documents. Review>Compare. Select More.

 
 

 Watermark. Page Layout>Click Watermark>Choose or Select Custom Watermark. 
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Microsoft SharePoint: 

 Setting Up A Site. 

 
 

 Libraries, version control, etc. 
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 Collaboration/inside and outside firm.  Lawyers can use with clients/opposing 

counsel/co-counsel. 
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Microsoft Outlook: 

 Customize Outlook for your best use (customize Ribbon and Quick Access Toolbar).  Go 

to File>Options>Select Either Customize Ribbon Or Quick Access Tool Bar>Make 

Choices.  Also, Arrow hides Ribbon.   

SAME AS WORD 

 

 You can customize Signatures, etc. File>Options>Mail>Signatures. 
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 Mail Message Arrival Notifications.  File>Options>Message Arrival. 

 
 

 More Months of Calendars.  Right Click over Calendar Area>Select number of months. 

Also select other items to display. 
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 Quick Steps. Home>Quick Steps. 
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 Creating and Applying Rules. Home>Rules>Manage Rules. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

19



 

MICROSOFT OFFICE 365 TIPS/TRICKS FOR LAWYERS  
BY JAMES PROVINCE, J.D.    
Page 15 

Copyright © 2012 by James A. Province. All rights reserved. 

 Delay Emails being Sent. Home>Rules>Manage Rules>New, etc. 
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 Calendar and Contacts. Share with Exchange. 

 
 

 Add Internet Calendar/Other Calendars.  Overlay: view>Overlay. 
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 New Window for Other Components of Outlook.  Right click over components you want 

to open in separate window and select “Open in New Window.” 
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Microsoft OneNote: 

 How to set up notebook. 

 
 Handwriting. 
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 Search handwritten notes. 

 
 

 Convert inked handwriting to type with one touch. 

 
 Search notes OCR of Web Clip. 

 
 

 To do and Tags for list and depositions/Links with Outlook Tasks and updates both. 

 
 

 Insert space between notes on the fly. 
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 Share Notebook/Recent Edits.  Share>Select. 

 
 

 Draw/Write/Erase/Lasso. Draw>Select. 

 
 

 Rule lines/Grid lines. View>Rule Lines. 
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Microsoft Lync: 

 Share Screen/Docs/Video Conference. Presence. IM.  

 
 

 Lawyers can use to have meeting with clients and opposing counsel to review and edit 

documents collaboratively.  
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 Tag busy contact: Right click on contact name and select “Tag for Status Change Alerts.”
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Metadata and Ethics  

In a Web 2.0 World  

 

 

 

 

 

  

      

L a w  O f f i c e  o f  D a v i d  T .  C o x  

1 3 0 0  C o n v e n t i o n  P l a z a  # 1 1 6   

S t .  L o u i s ,  M O  6 3 1 0 3  

3 1 4 - 8 2 7 - 5 8 2 6  

      

 

 

W h a t  m e t a d a t a  i s ,  h o w  i t  i m p a c t s  

t h e  p r a c t i c e  o f  l a w — a n d  w h a t  

p r o b l e m s  i t  m a y  p r e s e n t  i n  t h e  

f u t u r e .  

P L U S :  F i v e  b e s t  p r a c t i c e s  f o r  

m a n a g i n g  m e t a d a t a ,  a n d  t h e  A B A ’ s  

s t a n c e  v i s - à - v i s  i t s  M o d e l  R u l e s  o f  

P r o f e s s i o n a l  C o n d u c t .  
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Metadata – what it reveals could cost you 
 

As technology overtakes law practice management and other aspects of the legal profession, legal issues 

surrounding metadata are resurfacing in the Web 2.0 environment.   

We lawyers need to take stock and revisit the implications of proliferating 1s and 0s in our lives, as the 

possibility of violating state ethics rules dominates other concerns when it comes to metadata.  

But first, let’s discuss what metadata is.    

What is metadata? 
 

1. It is probably cliché to define metadata as "data about data," so I'll give you an example instead.  

If I throw out a series of numbers, like "12345", we would typically call these numbers "data," 

and with no additional context, these numbers are meaningless.   When  told these numbers are 

a  "ZIP code,” we now know that "12345" refers to the General Electric plant in Schenectady, 

New York.  Metadata adds meaning. 

Metadatai includes information about the means of creation of the data, the purpose of the data, the 

time and date of creation, the creator or author of data, the location on a computer networkii where the 

data was created, and even the standardsiii used.  For example, a digital imageiv may include metadata 

that describes how large the picture is, the color depth, the image resolution, when the image was 

created, and other data. A text document's metadatav may contain information about how long the 

document is, who the author is, when the document was written, and a short summary of the 

document.  A web pagevi also has metadata (source code) that can explain, for example, that Jonathan 

Frakes is not just a man's name, but it is the name of a movie director. 

More interesting for lawyers involved in litigation is the possibility that metadata can include 

information about the machine where the document was written, where the document was saved, 

version number and document format, names and network usernames of document authors.  All of 

these details can prove invaluable in questioning witnesses and engaging in discovery.  Metadata also 

includes the formulas in spreadsheets, text from other documents open at the same time (such as 

markups in word processors comparing different versions of a document), e-mail headers and server 

information, printer names, and even previously deleted text.   Previously deleted text can be viewed in 

Microsoft® Word® by using the markup view of a document.  If the document in question was prepared 

by or for an attorney, the markup view could easily reveal the deliberative process (and thus potentially 

violate a lawyer's duty of confidentiality). 

The Problem with Metadata 
 

Back in 2004, counsel for SCO Group (a provider of a proprietary version of the popular, open-source 

operating system, Linux®) demonstrated a profound lack of techno-savvy by electronically filing the 

29

http://en.wikipedia.org/wiki/Metadata
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/Technical_standard
http://imgur.com/pkBGu
http://imgur.com/auJks
http://imgur.com/tLzRv


 

 

Microsoft Word version of his client’s complaint against DaimlerChrysler and AutoZone, complete with 

metadata, thus disclosing part of their client’s litigation strategy.  Metadata hidden in the Microsoft 

Word version of a circulated version of the SCO Group’s complaint revealed to the media that before 

SCO Group filed its complaint, the focus of the lawsuit was not the eventual defendant — 

DaimlerChrysler — but was actually Bank of America.  Shortly before filing, the chosen venue was 

switched from California to Michigan.  The metadata in the complaint also revealed changes to and 

comments regarding SCO Group’s claims and damages. 

One high profile example of metadata mining became the focus of litigation involving Merck & Co, Inc.’s 

painkiller, Vioxx®, after The New England Journal of Medicine examined hidden tracked changes in a 

published manuscript for a crucial Vioxx clinical trial.  A journal editor was shown a Merck document 

during a deposition that revealed authors of the Merck study knew of heart problems that were not 

disclosed in the manuscript submitted to the journal.  Following the deposition, the editor and others 

started analyzing the drafts, raw data, and correspondence that Merck provided to the journal years 

earlier.  Their investigation revealed hidden metadata in the draft manuscript that confirmed that Merck 

researchers knew of the potential cardiovascular side effects of Vioxx years before it was 

marketed.  Further, the metadata showed that Merck had deleted data linking Vioxx to cardiovascular 

risk just two days before the manuscript was submitted for publication.  In November 2007, Merck 

announced it would pay $4.85 billion to settle thousands of Vioxx suitsvii.   

Don’t take metadata for granted. As seen in the previous examples, metadata has caused serious actions 

against some big companies that not only cost them the case, but damaged their reputation with the 

client and public. Don’t be caught unaware. 

Hide and Seek:  Metadata Mining and Scrubbing 

ABA Model Rules Help Answer Questions Raised by Metadata 
 

Three of the American Bar Association's Model Rules of Professional Conduct are relevant in dealing 

with metadata:  Competence  (Rule 1.1viii including preparation), Diligence (Rule 1.3ix, which includes 

zealous advocacy), and Confidentiality (Rule 1.6x).    These rules help answer the following questions 

raised by metadata:  

o What is the Sender's Duty When Transmitting Metadata? 

o May the Recipient Review or "Mine" Metadata? 

o Must the Recipient Notify Sender if Metadata is Found? 

Some states have specifically addressed one or all of these questions in formal opinionsxi about 

metadata.  The ABA has issued its own opinion on these questions as well.  The most contentious issue 

is the propriety of forensically “mining” documents for metadata.  Ethics committees for the ABA and 

the Maryland and Vermont bars have deemed metadata mining permissible, although they appear not 

to address the use of special software to “unscrub” a document from which the sender has affirmatively 
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tried to remove metadata.  A Colorado opinion also found uncovering metadata permissible but 

qualified this determination by stating that it would not be ethical to do so if a sender gave notice of an 

inadvertent transmission before the recipient begins extracting metadata.  Committees in two other 

jurisdictions--Minnesota and Pennsylvania--indicated that the ethical propriety of metadata mining is a 

fact-specific determination.  Nine jurisdictions have said that mining for metadata is inconsistent with a 

lawyer's obligations under the ethics rules. They are Alabama, Arizona, the District of Columbia, Florida, 

Maine, New Hampshire, New York, Oregon, and West Virginia.    

What Different States Have to Say 
 

Here's what Mainexii had to say on the subject:   "We find that an attorney may not ethically take steps 

to uncover metadata, embedded in an electronic document sent by counsel for another party, in an 

effort to detect information that is legally confidential and is or should be reasonably known not to have 

been intentionally communicated."  

Marylandxiii found that "subject to any legal standards or requirements (case law, statutes, rules of 

procedure, administrative rules, etc.), this Committee believes that there is no ethical violation if the 

recipient attorney (or those working under the attorney's direction) reviews or makes use of the 

metadata without first ascertaining whether the sender intended to include such metadata." 

Washington Statexiv opined that a lawyer's use of high-tech tools to extract “scrubbed” metadata 

presents more serious ethics concerns than the nonexploitative recovery of “unscrubbed” and 

absentmindedly transmitted metadata.  Although ethics rules “do not explicitly prohibit *attorneys+ from 

utilizing special forensic software to recover that is not readily accessible or has otherwise been 

'scrubbed' … such efforts would,” the panel said, “contravene the prohibition in RPC 4.4(a) against 

'us[ing] methods of obtaining evidence that violate the legal rights of [third persons+.'”   Such action also 

would “constitute 'conduct that is prejudicial to the administration of justice' in contravention of RPC 

8.4(d).” Moreover, the committee said that “such efforts would also violate the public policy of 

preserving confidentiality as the foundation of the attorney-client relationship.”  Accordingly, the 

committee opined that “the use of special software to recover … metadata that is not readily accessible 

does violate the ethical rules.” 

The American Bar Association Standing Committee on Ethics and Professional Responsibility in Formal 

Opinion 06-442xv and Formal Opinion 05-437xvi has answered the three questions posed above as 

follows.   

o What is the Sender's Duty When Transmitting Metadata? (The Sender has no duty) 

o May the Recipient Review or "Mine" Metadata? (Yes) 

o Must the Recipient Notify Sender if Metadata is Found? (Yes) 

Although the ABA imposes no explicit duty regarding metadata, it does suggest a number of methods for 

eliminating metadata (including "scrubbing," negotiating a confidentiality agreement, or sending the file 
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in a different format) for attorneys who are "concerned about the possibility of sending, producing, or 

providing to opposing counsel a document that contains or might contain metadata."  

After noting that some authorities have found metadata mining "ethically impermissible," the 

Committee states that it "does not share such a view, but instead reads the recent addition of Rule 

4.4(b)xvii identifying the sole requirement of providing notice to the sender of the receipt of 

inadvertently sent information, as evidence of the intention to set no other specific restrictions on 

receiving lawyer's conduct found in other Rules." 

ABA Formal Opinion 05-437 cites the Rule 4.4(b)xviii provision that a "lawyer who receives a document 

relating to the representation of the lawyer's client and knows or reasonably should know that the 

document was inadvertently sent shall promptly notify the sender." 

The Opinion goes on to state that Rule 4.4(b)xix"obligates the receiving lawyer to notify the sender of the 

inadvertent transmission promptly" but "does not require the receiving lawyer either to refrain from 

examining the materials or to abide by the instructions of the sending lawyer." 

Now you know how the ABA and certain States view metadata as it pertains to scrubbing, mining and 

what happens if you discover it. However, technology does not stand still and there will be further 

review and opinions by others. I encourage you to stay abreast of metadata issues, especially in the 

state where you are licensed to practice. 

Metadata and Discovery: Five Best Practice Tips 
 

Scrubbing files for metadata before turning them over in discovery could be unethical.  It could be 

viewed as destroying evidence, and there are sanctions for spoliation.  Some courts have found a 

presumption that metadata would have been favorable to an opposing party, though privileged 

information may be an exception.   

In the most comprehensive judicial analysis on the subject of whether metadata should automatically be 

produced in response to a discovery request, Magistrate Judge Waxse from the Federal District Court in 

Kansas, in a September 29, 2005 opinion (Williams v. Sprintxx), decided if a party, when told to produce 

electronic spreadsheets “in the manner in which they were kept in the ordinary course of business,” 

should be sanctioned for “scrubbing” the metadata and locking down certain data in cells of Microsoft® 

Excel® spreadsheets prior to producing them.  Plaintiffs in the case claimed that metadata had been 

scrubbed from the spreadsheets provided during discovery.  The court found that while the emerging 

standards governing electronic discovery appeared to have a general presumption against producing 

metadata in discovery, the employer in the case had to turn over the metadata since it had not claimed 

the electronic data as privileged information earlier in the case. 

Five Best Practice Tips 
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If you plan to share an electronic copy of a Microsoft® Word™ document with clients or colleagues, it is 

a good idea to review the document for hidden data or personal information that might be stored in the 

document itself or in the document properties (metadata). Because this hidden information can reveal 

details about your organization or about the document itself that you might not want to share publicly, 

you might want to remove this hidden information before you share the document with other people.   

1. Word has a built-in metadata scrubbing solution in the form of its document "inspection" tool.   

If you use Word, it is a good idea to always "inspect" a document before sending it on to a third 

party. 

2. Converting native files to Adobe®'s Portable Document Format (PDF) eliminates the most 

common forms of metadata (though the PDF file itself will have metadata associated with it).   

3. You can also scan a file and save it in Tagged Image File Format (TIFF) or Joint Photographic 

Group (JPG) format to eliminate much of the metadata associated with a native file format.   

4. There is software specifically designed to scrub files of metadata, including batch metadata 

removal tools which can process multiple files at once, to include e-mail client add-insxxi which 

are designed to remove metadata from e-mail attachments just before they are sent.    

5. Some server-based systems are designed to automatically remove metadata at the network 

gateway. 

If you hadn't heard about metadata before now, you will soon hear more about it as technology 

continues to shape and sometimes even control the practice of law.   

About the Author: 

David Cox is an attorney in St. Louis, Missouri focusing on Immigration, Intellectual Property, Criminal 
Defense, Business and Military Law. For six years, Mr. Cox litigated cases in the Air Force military justice 
system.  He represented the government as a prosecutor for two years and then spent four years 
exclusively defending Air Force members accused of military offenses. 

Mr. Cox began practicing United States immigration law in 2001 and has represented businesses and 
individuals in a wide variety of immigrant and non-immigrant visa matters. He has advised small 
business about matters ranging from concept development to incorporation, from funding to 
dissolution. 

He has experience in marketing, advertising and developing a business web presence, including new 
media. He has worked as a software executive and has developed web-based delivery of software 
services. Mr. Cox has an undergraduate degree in International Relations from Brigham Young 
University, and received his JD from the University of Utah’s S.J.  Quinney College of Law. 

He has been practicing law since 1993 and is admitted to practice law before the state bars of Utah, 
Georgia and Missouri, and in front of the United States District Court for the Eastern District of Missouri. 
He is also admitted to practice before the Court of Appeals for the Armed Forces. 
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Outlook Tips

Mail
     U Quickly add an attachment to a new message     Locate the file, for example a .doc file in your

My Documents folder, and then drag it to your Inbox. Outlook opens a new e‐mail message with
the file attached. You can also drag multiple files.

     U Find all messages sent by the same person     Right‐click a message from that person, and then
on the shortcut menu, point to Find All. Click Messages from Sender. The Advanced Find dialog
box displays a list of all messages in a folder from that person.

     U Jog your memory with a follow‐up flag    Create a follow‐up flag as a reminder to follow up on a
message. On the Actions menu, click Follow Up and click the flag color of your choice. Flag that
message fast – Select a message in the message list, and then press INSERT.

     U Save multiple attachments at one time     Open the message. On the File menu, click Save
Attachments. Click OK, and then click the folder where you want to save the attached files. Click
OK.

     U View all your unread messages in the Inbox     On the View menu, point to Arrange By, point to
Current View, and then click Unread Messages in This Folder.

     U Delete names from the AutoComplete list     Select the unwanted name by using the UP ARROW
or DOWN ARROW key and then press DELETE.

     U See more messages in your Inbox with single‐line view     Change from multiline view to
single‐line view. On the View menu, point to Arrange By, and then click Custom. Click Other
Settings. Clear the Use multi‐line layout in widths smaller than n characters check box.

     U Was an important message sent to the Junk E‐mail folder?    If an item gets moved to your Junk
E‐mail folder by mistake, select the message, and then press CTRL+ ALT+J.

     U Receive notifications when messages you send are delivered or read     On the Tools menu, click
Options, and then click the Preferences tab. Click E‐mail Options, and then click Tracking
Options.

    U Send a message to multiple people without revealing other recipients' identities    To send a
message to someone without other recipients of the message knowing, use the Bcc line in the
message. Bcc stands for blind carbon copy. If you add someone's name to the Bcc line, a copy of
the message is sent to that person, but his or her name is not visible to other recipients.

Calendar
     U Abbreviate when entering meeting times    When you enter appointments in the Calendar, you

can save time by typing abbreviations and allowing Outlook to fill in the rest. For example, if you
want to enter a 6:00 P.M. meeting, open a new meeting request and then type 600p. You can
also use phrases such as "tomorrow" or "next Monday," and Outlook automatically inserts the
correct date.

     U Quickly display several days side by side in Calendar     In the date picker, drag over the dates
that you want to view.

     U Quickly create an appointment in Calendar     Click the day, drag over the block of time when the
appointment occurs, and then type a description.

     U Quickly create an all‐day event in Calendar     Click the day heading that you want, and then type
the name of the event. If the event lasts several days, click the first day heading, drag across all
days, and then type the event name.

     U Change the number of days shown in Calendar     In Calendar view, press ALT+number, where
number represents the number of days to show in the view between 1 and 9. Use 0 for a 10‐day
view.

     U Quickly copy an appointment in your Calendar     Hold down CTRL and drag the appointment to a
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new time or date.
     U Change the time periods in the Calendar grid     You can change the default setting for 30‐minute

time slots to 5‐, 6‐, 10‐, 15‐, or 60‐minute time slots. Right‐click the Calendar, click Other
Settings, and then click the number you want from the Time Scale list.

     U Quickly switch to viewing by month in Calendar     Click in Calendar, and then press ALT+EQUAL
SIGN.

Contacts
     U Add a new contact from an e‐mail message     Open the message. In the From field, right‐click

the name you want to make into a contact. On the shortcut menu, click Add to Outlook
Contacts.

     U Create a task related to a contact     Click the contact, click the Actions menu, and then click New
Task for Contact.

     U Quickly move through contact address cards with the arrow keys     Press HOME to move to the
first card. Press END to move to the last card. Use the arrow keys to move up, down, and across
the columns.

     U Create a contact card from a message     Drag the message to the Contacts button in the
Navigation Pane, and then fill in the rest of the information for the contact.

     U Send a message fast to a contact     Click the contact and then on the Actions menu, click New
Message to Contact.

     U Quickly schedule a meeting with a contact     Click the contact and then on the Actions menu,
click New Meeting Request to Contact.

     U Quickly change the number of columns of contacts in your Contacts list     Just drag one of the
vertical dividers that separate the columns.

     U Quickly create a contact with the same company name and address as another contact     Select
the existing contact in your Contacts list, and then on the Actions menu, click New Contact from
Same Company.

Notes
     U Send that note fast!    Click the note icon in the upper‐left corner of the open note and then click

Forward.
     U Quickly create a note from text in another program     Select the text and drag it onto the Notes

button in the Navigation Pane.
     U Make your notes more eye‐catching    Change the color of an Outlook note by right‐clicking the

note icon in the Notes pane, pointing to Color, and then clicking a new color.

Tasks
     U Change the order of tasks in a task list     In the Task pane, when tasks aren't grouped or sorted,

just drag the tasks up or down in the task list.
     U Quickly create a task from a file containing details about the task     Drag the file to the Tasks

button in the Navigation Pane. A new task opens with the file attached. Fill in the rest of the
information about the task, and then click Save and Close.

     U Quickly send a new message about a task     Drag the task to the Mail button in the Navigation
Pane. This creates a new message with the task name as the subject and the task details in the
body of the message.

     U Quickly mark a task complete    Right‐click the task and then click Mark Complete on the shortcut
menu.

     U Quickly assign a task     Right‐click the task, and then on the shortcut menu, click Assign Task and
type a name in the To box.
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Journal
     U Quickly record any item in Journal     Drag the item to Journal view in the Navigation Pane.
     U Quickly go to another date in Journal     Click the date heading at the top of the timeline, and

then click the month and day that you want to view.
     U Try the quick way to open Journal entries     To open the item, document, or contact in a Journal

entry, double‐click the icon in the Journal entry.

General
     U Quickly attach a file to a message, task, appointment, meeting request, journal entry, or contact  

  Open the item, and then on the Insert menu, click File. Locate the file you want to attach.
     U Create a document, worksheet, or presentation     If you have other Microsoft Office programs

installed, you can quickly create a new Microsoft Word document, Microsoft Excel worksheet, or
Microsoft PowerPoint presentation by pressing CTRL+SHIFT+H.

     U Check your spelling in Outlook    On the Tools menu, click Options. Click Preferences, and then
on the Spelling tab, select options to allow Outlook to correct your spelling, including creating a
custom dictionary of frequently used terms and choosing a dictionary in another language to
check your spelling.
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Outlook Shortcut Keys

E‐mail Shortcuts
Ctrl‐Shift‐I  Go to Inbox
Ctrl‐Shift‐O  Go to Outbox
Alt‐S or Ctrl‐Enter  Send
Ctrl‐P  Print
Ctrl‐R  Reply to a message
Ctrl‐Shift‐R  Reply all to a message
Ctrl‐F  Forward a message
Ctrl‐Alt‐F  Forward as attachment
Ctrl‐Alt‐J  Mark a message as not junk
Ctrl‐Shift‐I  Display blocked external content (in a message)
Ctrl‐Shift‐S  Post to a folder
Ctrl‐Shift‐N  Apply normal style
Ctrl‐M or F9  Check for new messages
Ctrl‐N  Create a new message (when in Mail)
Ctrl‐Shift‐M  Create a new message (from any Outlook view)
Ctrl‐O  Open a message
Ctrl‐Shift‐G  Display the Flag for Follow‐up dialog box
Ctrl‐Q  Mark a message as read
Ctrl‐U  Mark a message as unread
F4  Find or replace in a open message
Shift‐F4  Find next in an open message
Alt‐Enter  Show the properties for the selected item
Ctrl‐B  Display Send/Receive progress

Creating Items
Ctrl‐Shift‐A  Create a Appointment
Ctrl‐Shift‐C  Create a Contact
Ctrl‐Shift‐L  Create a distribution list
Ctrl‐Shift‐X  Create a fax
Ctrl‐Shift‐F  Create a folder
Ctrl‐Shift‐J  Create a Journal entry
Ctrl‐Shift‐Q  Create a meeting request
Ctrl‐Shift‐M  Create an e‐mail message
Ctrl‐Shift‐N  Create a note
Ctrl‐Shift‐H  Create a new Microsoft office document
Ctrl‐Shift‐S  Post to this folder
Ctrl‐T  Post a reply in this folder
Ctrl‐Shift‐P  Create a search folder
Ctrl‐Shift‐K  Create a Task

General Shortcuts
Ctrl‐1  Go to mail
Ctrl‐2  Go to Calendar
Ctrl‐3  Go to Contacts
Ctrl‐4  Go to Task
Ctrl‐5  Go to notes
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Ctrl‐6  Go to the folder list in the Navigation Pane
Ctrl‐7  Go to shortcuts
Ctrl‐.(period)  Go to the next message (when you have a message open
Ctrl‐,(comma)  Go to the previous message (when you have a message open
F6 or Ctrl‐Shift‐Tab  Move between the Navigation Pane, the main Outlook window,

the
Reading Pane and the To‐Do Bar
Tab  Move between the main Outlook window, the smaller panes in

the Navigation Pane, the Reading Pane and the sections in the
To‐Do Bar

Arrow Keys  Move around within the Navigation Pane
Ctrl‐Y  Go to a different folder
F3 or Ctrl‐E  Go to the Search box
Alt‐Up arrow or Ctrl‐,(comma)
or Alt‐Page Up  In the Reading Pane, Go to the previous message
Alt‐Down arrow or Ctrl‐.(period)
or Alt‐Page Down  In the Reading Pane, Go to the next message
Left arrow or Right arrow Collapse or expand a folder in the Navigation Pane
Alt‐B, Alt‐Left arrow  Go back to the previous view in main Outlook window
Alt‐Right arrow  Go forward to the next view in main Outlook window
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